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Database

1) Define the following term with example:

Tuple

A record in a relation /Table is called tuple

Relation

Table in a database is called relation where data is organized in rows and columns

Cardinality

No of records /Rows in a Relation is called Cardinality

Degree

No of Fields /Attribute in a Relation is called Degree

Primary Key

The PRIMARY KEY constraint uniquely identifies each record in a table.
Primary keys must contain unique values.
A primary key column cannot contain NULL values.

Each table can have only ONE primary key.

Foreign Key

A foreign key is a field in a relational table that matches the primary key column of
another table. The foreign key can be used to cross- reference tables

Alternate Key

An alternate key is similar to a primary key. It accepts null values; where as the
primary key does not.

Candidate Key

A candidate key is a combination of attributes that can be uniquely used to identify a
database record. Each table may have one or more candidate keys. One of these
candidate keys is selected as the table primary key.

Composite Key

A composite key is any database key that consists of two or more columns/attributes.

relationship

Relationship is association between relations/tables of Database which is done
through foreign key

DBMS

Database Management System A collection of programs that enables you to store,
modify, and extract information from a database.

RDBMS

RDBMS stands for Relational Database Management System. RDBMS store the data
into collection of tables, which might be related by common fields (database table
columns). RDBMS also provide relational operators to manipulate the data stored into
the database tables.

Object Linking and Embedding (OLE) is a technology developed by Microsoft that
allows embedding and linking to documents and other objects
OLE Data type is used to store sound , picture, file etc. to database
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2) Differentiate Between following

a) Text & Memo b) Number & Auto Number c) Tuple & Attribute d) Hiding & Freezing Access column
e) Datasheet & Design View f) Text & Number g) Currency & Date datatype

Number

Auto Number

The Number data type can be used for storing
various kinds of numbers such as integers,
decimals etc.

The Auto Number data type is used for storing only
integer numbers.

These values are input by the user

These values are automatically generated when a
record is added.

They need not be in sequence

The Auto Number data type is used or unique
sequential (incrementing by 1) numbers

Text

Memo

1. Text fields may store up to a maximum of 255
characters
2. Text Field can be Sort

1. Memo fields can store up to 1 gigabyte of
characters

2. Fields of memo data type cannot be grouped while
filtering and it is not possible to sort them.

Tuple

Attribute

Record in a relation is called Tuple

Field /column in a Relation is called Attribute

Tuple provide information about one entity

Attribute provide data for particular

Hiding Access column

Freezing Access column

Hiding column makes the column disappear or hide
for viewing

Freezing column means that particular column will not
move when use try to scroll the column vertically.

Datasheet View

Design View

User can add delete modify the records
we can add attribute in datasheet view

User can create a table structure by defining attribute
and its data type

You can add attribute also in this view

You cannot add records in this view

Currency

Date

It allow to store monetary values with appropriate
sign, commas and decimals

It allows to store Date values. It can't hold more
than 8 digits.

It can store system date, containing date and time
information.

Primary Key

Foreign Key

Key which uniquely Identify a Record in
Relation/table

It's a Primary key of one table present in second table
.Key which is used to join two table

Cannot be left blank

Can be blank

No duplicate values

Duplicate values allowed

Candidate Key

Alternate Key

All keys which can be Primary Key are known as
Candidate Key

After choosing Primary Key from Candidate Key left over
keys are known as Alternate Keys

One to One Relationship

One to Many Relationship

Both Table have one matching record only

There are more than one record for a linking value on
one side of relationship

Each Primary Key values relates to only record in
the related table

One Related table values is assigned to many Primary
Key Values
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3) Name the Following
i) An attribute which is capable of becoming a primary key. Candidate key
ii) The view in which we can add, edit and view records in MS-Access. Datasheet View
iii) A datatype used for linking to an internet or another location in the database. Hyperlink

iv) A built in set of rules Access uses to make sure that the relationship is valid . it can also prevent
accidental deletion or editing of data. Validation Rule

v) Alphanumeric characters upto 65,535 characters. Memo

vi) The number of records in a relation. Cardinality

vii) A data type used for logical value(true/false) in the database. Boolean

viii) A key that does not allow Null values and must always have a unique value. Primary Key

ix) The number of fields in a relation. Degree

X) Key used to relate two tables. Foreign key

xi) Any two data types used to store alphanumeric characters in Access. Text and memo

xii) sound,picture, other data such as MS-Word /MS-Excel file can be store in this data type OLE

xiii) A data type which can be used to automatically store monetary values with appropriate sign, commas
and decimals Auto number

xiv) Data type which can store Photograph of a person OLE

xv) Extension of MS-Access Database file .mdb or .Accdb

xvi) A part of the Microsoft Office suite that is used to create and manage databases MS Access

xvii) Key which can uniquely identify the record but it is not be primary key Alternate Key

XViii) Key which is made up of two or more attribute Composite Key

4) Study the following data and answer the questions given below :
Table: Patient

Name P_no
Mohan P_101 21/03/2006 301
Priya P_204 03/04/2006 134
Suraj P_375 15/01/2006 204
Komal P 424 24/06/2006 134

Date Admm Doc_no

Table: Doctor

Doc_no

Doc_Name

Speciality

134

ALK, Sharma

Surgery

204

R. Khurana

Dentist

301

S. Shyam

Neurology

280 P.John

Dermotology

Name the field, which can act as the primary key for the table Patient and the table
Doctor respectively. Ans P_No, & Doc_No

Name the field, which can act as the foreign key for the table Patient. Doc_no

What type of relationship exists between the table Patient and the table Doctor ?
One to Many
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5 Consider the following tables SENDER and RECIPIENT. Study the following data and answer the
guestion given below :

Table SENDER
SENDERID | NAME ADDRESS CITY
Data Type Data Type Data Type Data Type Text
Text Text Text/Memo
Table : RECIPIENT

RECID SENDERID RECNAME RECADRESS RECCITY
Data Type Data Type Data Type Data Type Data Type
Text Text Text Text/Memo Text
0] Suggest data types that should be used for each of the fields in the table RECIPIENT.
(i) What type of relationship exists between the table SENDER and the table RECIPIENT? One to
One
(iii) Name the field that can be set as a foreign key in the table RECIPIENT.SENDERID

6) Study the following-data and answer the questions given below :
Table: Customers

Customer Cust_No Acct_CreateDt Amount
ManishCNR_101 21/03/2001 450000
Rahul CNR_204 03/04/2001 250000

Manpreet CNR_375 15/01/2001 350000
Rajen CNR_424 24/06/2001 650000

Table: Transactions

Trxn_ID Cust_No Trxn_Date Withdrawal _Amt
2310201201 CNR_101 23/10/2012 14500
2410201202 CNR_101 24/10/2012 1500

2110201203 CNR_375 21/10/2012 12000
2410201204 CNR_424 12/10/2012 16000

a. the primary key for the table Customers: Cust_No, and the table Transactions
respectively. Trxn_ID
b. foreign key for the table Transactions. Cust_No
c. Cardinality : 4 and Degree :4
7) Study the following data and answer the questions given below :
Table : Pancard.mdb
Permanent Account Number Name Father Name Date Of Birth
Data Type: Text Data Type: Text Data Type: Text Data Type:
Date

Table: Moneytransaction .mdb

Permanent Account Number Debit Credit Balance Transcation_ID
Data Type: Text Data Type: Data Type: Data Type: Data Type: Text
Currency Currency Currency
i. Suggest the data types that should be used for each of the fields in the pancard table .
ii. Write the relationship between “pancard” and “moneytransaction” table. One to Many
ii. Name the field that can act as a primary key in “pancard” table Permanent Account Number
and name the foreign key of “moneytransaction” table Transcation_ID
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8 ) Suggest the data types for the following Teacher Table:
T Code - Teacher’'s Code generated Automatically Auto number
T _Name - Teacher's Name Text
DOB - Date of Birth Date
Basic_Sal - Basic Salary Currency
Qualification -Qualification of a teacher (List should appear like- M.A., B.A, ....) Text
Photo -Photograph of a teacher OLE
Bio-Data -Ms-Word file. OLE
Blog -Teacher’s Blog on Internet Hyperlink

Study the following data and answer the questions given below:

Table: Video

Title Vid_No Actor Price

Data Type: Data Type: Data Type: Text | Data Type:
Text Auto Number Currency
Troy 1001 Sunil Nehra 315.00
Men In Black | 1002 Neha 125.70
Speed 1003 Shuhita 220.10
Spider Man 1004 Pawan 480.00

Table: Issue
Member_ No | Issue Date | Return_Date Vid_No

Data Type: Data Type: | Data Type: Data Type:
Text Date Date Auto Number

P123 07/12/2009 | 07/14/2009 1001

T102 09/30/2009 | 10/01/2009 1002

T096 10/08/2009 | 10/10/2009 1002

P103 10/03/2009 | 10/05/2009 1001

T089 09/30/2009 | 09/04/2009 1004

PO37 04/05/2009 | 04/05/2009 1003

1) Suggest data types for each of the fields in the table Video

2) the primary keys for the table Video Vid_No and the table Issue. Member_No
3) What type of relationship exists between table Video and Issue. One to Many

10) What is the significance of database?
The significances of a Database are:-
1. It reduces the redundancy of data.
2.1t gives a distributed data management system.
3. It avoids the inconsistency of data.
4. It maintains the data integrity

11) Write down any two disadvantages of using a database system.

12) What is RDBMS? Name two RDBMS
Relational Database Management System. It a Database software which use table to store data
Examples of RDBMS are MS Access/ MYSQL / Oracle

13) What do you mean by Data Redundancy? How Ms-Access help to reduce it
Data redundancy is a condition created within a database or data storage technology in which
the same piece of data is held in two separate places. Whenever data is repeated, this
basically constitutes data redundancy. Use of Primary key And foreign key helps in reducing
Data Redundancy
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14) What is Validation Rule and Validation text in MS Access
A built in set of rules Access uses to make sure that the relationship is valid . it can also
prevent accidental deletion or editing of data
15) What is Input Mask? the data types that do not support this property
Input masks provide a set format for data entry in a field by using characters and symbols.
When you apply an input mask to a field, anyone who inputs data in that field must follow the
specific pattern defined by the input mask.
MEMO/OLE/Yes/No(Boolean) does not support Input Mask
16) What is Default Value
Value which is set to appear in field before inputting any value by user is called default value
17) What is Sorting of Data
Sorting of Data is arranging data in ascending or descending order
18) What is Query
Query is used to Extract data based on certain condition is called Query

19) Explain Three Types of Relationship

e One to One : In a one-to-one relationship, a row in table A can have no more than one matching
row in table B, and vice versa. A one-to-one relationship is created if both of the related columns are
primary keys or have unique constraints
One to Many: A one-to-many relationship is the most common type of relationship. In this type of
relationship, a row in table A can have many matching rows in table B, but a row in table B can have
only one matching row in table A
Many to Many: In a many-to-many relationship, a row in table A can have many matching rows in
table B, and vice versa. You create such a relationship by defining a third table, called a junction
table, whose primary key consists of the foreign keys from both table A and table B.

fStudy the following data and answer the questions given below:

| Table: Item

ltem_Name Item_Code Price

Electric Iron 1002 525.00
Hand Mixie 1014 695.00
Electric Shaver 1001 350.00
Coffee Maker 1020 1275.00

| Ta_ble: Sales

Cust_no Bill_No Sale_Date Quantity Iltem_Code
1432 10233 07/12/2003 2 1001
2042 ’ 10234 09/30/2003 1002
1245 10235 ‘1 10/08/2003 1002
1432 10236 10/03/2003 1014
1324 10237 09/30/2003 1001
1565 10238 04/05/2003 3 1020

i) Name the fields, which can act as the primary key and foreign key for the table Item and the »tab!e
Sales respectively. .

ii) What type of relationship exists between table tem and table Sales?
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Question Based on Multimedia

1)
2)

3)

Write a short note on how multimedia is being used in healthcare.

Write a short note on Virtual Reality

Computer Generated Environment which stimulate the real world situation with the use of
Multimedia. It is used in Video Gaming / Flight Simulation

Write a short note on Video Conferencing

Video Conferencing is live interaction of people sitting far from each other using Computer
System/ Webcam /Speaker /Headphone and conferencing software using network(internet
/Intranet)

Write a short note on how multimedia is being used in Education

What is Digital Library
Digital Library is a collection of Electronically /Digitized text /audio and video material
available for use in the form of CD/DVD/Online on internet.

.What is Information Kiosk
Information Kiosk is a Interactive Screen which provide information

What is Video on Demand(VOD)
Video on Demand is a Interactive process to select video to watch over network on demand by

paying.

Write a short note on Different File formats:
i) GIF : ii))MPEG ii))AVI iv) JPEG v) BMP vi) MIDI vi) WAV vii) SWF viii) PSD ix) DAT x) PDF

Format | Full Form

GIF Graphics Interchange It does not support high resolution and can take 8 bits color
Format combination yielding only 255 colors.

JPEG/ |Joint Photographic | It supports high resolution and can take 24 bits color combinations
JPG Expert Group yielding millions of colors.

BMP |BITMAP Image File |BMP files are Windows Bitmap files. They are usually 8-bit color
images (256 colors) and can be viewed by many programs
including Windows Paintbrush. BMP files can be used as

haclzaraiinde far tha \AMindnwie dacltan

Motion Picture is another type of file format formed by ISO for the storing and
Expert Group transmission of audio and video contents.

Audio Video AVl is supported by all computers running Windows, and by the
Interleave most popular web browsers. It is a very common format on the
Internet, but not always possible to play on non-Windows computers

Photoshop Standard |PSD signifies an Adobe Photoshop graphic file. They are open able
Document on Pentium and Macintosh systems by Adobe Photoshop.

Audio Input File Its Audio file Format
Format

Musical Instrument | MIDI files can be played with the Windows MIDI sequencer. They
Digital Interface are music files that conform to the MIDI standard. Play them with
Media Player on the Pentium computers, or load them into
MusicProse or Finale on a Macintosh.
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WAV

Waveform Audio
File Format

WAV (wave) files are Microsoft's native audio sound format. WAV files
can include 8-bit or 16-bit sound, in mono or stereo. They can be
played on Pentium computers with Media Player and wplany.

Advanced Systems
Format

Formerly called Advanced Streaming Format, ASF is a proprietary
digital audio/video container format from Microsoft, created for
streaming media as part of the Windows Media framework

Tagged Image File
Format

These files are uncompressed true color images. Most graphics
programs allow you to store TIFFs with compression. These files can
be opened by many graphics programs including xv, Lview, and
Photoshon

Portable Document
Format

It is created by Adobe Acrobat. An Enhancement of the Postscript
language, PDF files contain all the same text and page layout
information but can include many WWW features such as images,
links, and heading references. PDF files can be viewed using Adobe
Acrobat software.

The Adobe Flash animation source file that is used during development
before being saved typically as an .SWF file. Flash video however,
usually has the FLV of F4V extension and is considered it's own format
separate from FLA.

MP3 (MPEG-1 Audio Layer llI)

Part of the MPEG-1 video encoding format, able to store good quality
audio into small files, by filtering out audio that most humans cannot
hear. MP3 has become one of the most popular formats for buying and
sharing digital music,

Small Web Format

SWF (Small Web Format)

Previously standing as an abbreviation for Shockwave Flash, SWF is a
file format of a compiled FLA used by Adobe Flash. A SWF may
contain vector graphics and rich media including images, audio, and
video. It is widely adopted plugin for many desktop Internet browsers,
although availability is more limited on mobile devices. It is more
common for modern Flash video to have the FLV extension, however.

Windows Media
Video

WMV (Windows Media Video)

A video compression format for several codecs by Microsoft, designed
originally for streaming applications on the Internet. It has also become
adopted as a video format compatible with Blu-Ray discs. It is often
compared to MPEG-4 and H.264 in terms of video quality.
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9) Define the following :

FLOSS | Free/Libre/Open | software that is liberally licensed to grant the right of users to study,
Source change, and improve its design through the availability of its source code

Software
0SS Open  Source | Open Source Software are distributed under License that meets the

Software Open Source Definition or that is in the public domain license This
permits users to use, change, and improve the software, and to
redistribute it in modified or unmodified forms. It is very often
developed in a public, collaborative manner.

Free Software | is a non-profit corporation founded by Richard Stallman to support the
Foundation free software movement, a copy left-based movement which aims to
promote the universal freedom to distribute and modify computer software.
oSl Open Source | It is an organization dedicated to promoting open source software. is a
Initiative development method for software that harnesses the power of distributed
peer review and transparency of process.

w3cC World Wide | The World Wide Web Consortium (W3C) is the main international
Web Custodian | standards organization for the World Wide Web (abbreviated WWW or W3)
GNU GNU is a computer operating system composed entirely of free software

0) Explain the following with example : | ) Freeware Il) Shareware IIl) Proprietary Software
Example
Freeware Freeware (free software) is computer software that is available for | Open Office
use at no cost or for an optional fee. Software classified as freeware
is normally fully functional for an unlimited time with no cost,
monetary or otherwise. Freeware can be proprietary software
available at no price.

Shareware term shareware refers to proprietary software that is provided to | Winzip, System
users without payment on a trial basis and is often limited by any | Mechanic 8.0,
combination of functionality, availability or convenience. Easy Movie
Splitter 2.5.3
Proprietary The term “proprietary software” are copyright software by owner MS Office
Software who can exercise control over what users can do with the Adobe
software, in contrast to public domain. It is neither free nor open Photoshop
source.

Difference Between Freeware and Shareware
Freeware Shareware

Freeware is copyrighted computer software which | The term shareware refers to commercial
is made available for use free of charge, for an | software that is copyrighted, made available for
unlimited time. free of charge for limited period of time
All the features are free. all features are not available, or have limited use.
Freeware programs can be distributed free of cost. | Shareware may or may not be distributed freely.
In many cases, author’s permission is needed, to
distribute the shareware.
Example MSN Messenger Yahoo Messenger | Winzip, Cuteftp, Getright
Google Talk,
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11) What is localization of software
Localization of Software means translating user interface of software in regional language for
easy understanding of people living in that area.

12) Give the full Form of following : a) PHP b) JSP C)ASP, D)ASCII
e)ISCII

PHP Personal Home Page Hypertext Preprocessor, is a widely used, general-purpose
scripting language that was originally designed for web
development, to produce dynamic web pages.

JSP Java Server Page is a server side Java technology that allows software
developers to create dynamically generated web pages, with
HTML, XML, or other document types, in response to a Web
client request to a Java Web Application container (server).
Active Server Page is a server side Scripting technology that allows software
developers to create dynamically generated web pages, with
HTML, XML, or other document types, in response to a Web
client request to a Web Server (1IS)

ASCII American Standard Code of Information Interchange

ISCII Indian Standard Code of Information Interchange

Unicode | It is an industry standard whose goal is to provide means by which text of all forms
and languages can be encoded for use by computers

Write short note on a)MYSQL b) Tomcat c) Linux d)Open Office e) Python

MYSQL MySQL, the most popular Open Source SQL database management
system, is developed, distributed, and supported by Oracle Corporation.
Tomcat It is an open Source web server Software. Tomcat is an application
server from the Apache Software Foundation that executes Java servlets
and renders Web pages that include Java Server Page coding.

Linux Linux is an operating system, software that manages a computer. It is
similar to Microsoft Windows, but it is entirely free. The accurate hame
is GNU/Linux but "Linux" is used more often.

Open Office open office is Open source Application software suit which is available
free of cost. It is an alternative to Microsoft office

Python Python is an interpreted, object-oriented, high-level programming
language with dynamic semantics

14) What is Open Source Software Name three Website which promotes open source software
Open-source software is computer software with its source code made available in which the copyright
holder provides the rights to study change and distribute the software to anyone and for any purpose.
WWW.0opensource.org:
www.sourceforge.net

www.osalt.com
www.fsf.org The Free Software Foundation (FSF) is a nonprofit with a worldwide mission to promote
computer user freedom and to defend the rights of all free software users.

www.gnu.org
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Networking

1) What is Network Give three Advantages of Network

1) Sharing hardware 2) Sharing data and information 3) Sharing software 4) Facilitating
communications

2) Give 3 difference Between LAN/MAN/WAN
LAN / MAN MAN WAN

Area covered is restricted to | Area covered is around the city | Area covered has no limitation
room/Building (10-20 KM)

Very faster — speed in Gbps Relatively low — speed in Mbps Relatively low — speed in Mbps
Owned by a single organization Owned by multiple organization Owned by multiple
School or Hospital Network Cable TV network Weather Forecasting /Railway/
Airways Reservation Network

3) Give Two Difference Between LAN & WLAN
LAN is Wired Network WLAN is Wireless Network
LAN Area is Building (1-2 Km) WLAN Are is Smaller than LAN restricted to room

Define the following Term a)Hub b)Switch c)Router d) Gateway e)bridge f)Repeater gyMODEM
Hub A hub is a device for connecting multiple twisted pair or fibre optic devices together and
making them act as a single network segment.

Switch A network switch is a small hardware device that joins multiple computers together within
one local area network. Network switches are capable of inspecting data packets as they
are received, determining the source and destination device of each packet

Router A router is an electronic device that interconnects two or more dissimilar
computer networks

Gateway A gateway is a network point that acts as an entrance to another network It is used to
connect heterogeneous networks that use different protocols and have different network.

Bridge Bridging is a forwarding technique used in packet-switched computer networks. It is
device generally used to connect two or more similar network

Repeater A network device used to regenerate or replicate a signal if the distance is more than
90m.

Modem Modem (modulator-demodulator) is a device that modulates an analogue carrier signal
to encode digital information, and also demodulates such a carrier signal to decode the
transmitted information.

Give the Full Form of Following a) FTP b) IMAP c)PPP d)HHTP e)SMTP

FTP File Transfer protocol- It is a primary method to transfer files over the Internet. FTP transfers
files to and from a remote server

IMAP Internet Message Access Protocol is an Application Layer Internet protocol that allows an e-
mail client to access e-mail on a remote mail server.

SMTP Simple Mail Transfer Protocol (SMTP) is an Internet standard for electronic mail (e-mail)
transmission across Internet Protocol (IP) networks

VOIP Voice over Internet Protocol (Voice over IP, VolP) is a communication protocols and
transmission technologies for delivery of voice communications and multimedia sessions over
Internet
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HHTP Hypertext Transfer Protocol (HTTP) is a networking protocol for distributed, collaborative,
hypermedia information systems. HTTP functions as a request-response protocol in the client-
server computing model.

PPP PPP (Point-to-Point Protocol) :In networking, the Point-to-Point Protocol, or PPP, is a data
link protocol commonly used in establishing a direct connection between two networking
node

6) What is topology? Difference Between Star / BUS /Ring topology

Bus Topology All of the computers are linked to a single central cable.
o i o % All data passes through one central cable

_T_; ==

T % this means that the network has a single point of failure
% Not fault tolerant, if the central cable breaks the entire
- network fails
—— % Cheap and simple to set-up

Ring Topology Each networked computer is connected to two others in a
- closed ring. Sometimes two rings are used to increase the
— fault tolerance

! % Ring topologies are more expensive than bus
L % Hardware to control data transmission is more expensive
l % the actual ring shape is often not immediately obvious

% The ring can be within a central box with each computer
- connected the same as in a star topology

This is a very common topology.

% Each computer is connected to a single central hub

% When a computer sends data the hub transmits it to all of

the computers on the network

% A break in a cable only affects the computer it connects to
- all others remain unaffected

. % More fault tolerant

% High cabling costs compared to bus topology

7) Name the following :
i) the transmission media that can be used in
a)Sparsely populated areas Radio Link/ b) Unidirectional Fiber optics
i) A general purpose client-server internet facility that facilitates remote login. Telnet
ii) Software categories that has restriction on using and copying software and enforces a license fee.
Proprietary Software
iii) Name the transmission media that use electromagnetic waves ranging in frequencies between 3

KHz and 1 GHz Radio Frequency ii) 1 GHz and 300 GHz  Microwave
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8) Explain the following :

Firewall

A system designed to prevent unauthorized access to or from a private network. Firewalls
can be implemented in both hardware and software, or a combination of both

Cracker

The people who break and enter a computer/network without having authorised access
and with malicious intent like steal data, delete files, corrupt files, phising and farming

Hacker

The people who break and enter a computer/network without having authorised access
and with no malicious intent

GSM

GSM (Global System For Mbile Communication) GSM is a digital mobile telephony
system that digitizes and compresses data, then sends it down a channel with two other
streams of user data, each in its own time slot.

CDMA

CDMA (Code Division Multiple Access) :CDMA refers to any of several protocols used in
so-called second-generation (2G) and third-generation (3G) wireless communications.

GRPS

GPRS General packet radio service (GPRS) is a packet oriented mobile data service on

the 2G and 3G cellular communication systems global system for mobile communications
(GSM).

intranet

It is a local collection of interconnected network of computer device, govern by the local
authority. A privately owned network is termed as intranet

Interspace

It is a vision of what the internet will become, where users correlates information in
multiple ways from multiple sources

SMS

SMS(Short Message Service) is type messaging service meant for exchanging short text
messages on phone, web or mobile Communication system

Computer
Virus:

The type of Malware which destroys a targeted program on a computer devices like
personal Computer, Laptop etc. Sometimes, it destroys the whole device itself once it
transmits to it from another infected host.

Malware

The program or scripts which are harmful to the computing devices and can destroy the
communication and computing devices are called Malware

Spyware

It tracks the different types of activities like user activities, scheduled tasks, operating
system health check activities etc .It can be scripts, programs, cookies etc.

Cyber Law:

The Information Acts and Rules articulated to regulate and control the illegal practices on
Internet or in any 'electronic devices' connected through internet are called Cyber Laws

9) Difference between Twisted pair /Co-axial / Fiber-Optics cable

Twisted pair

Co-axial

Fiber-Optics

it has adequate performance
It is one of the cheapest
media of transmission

It is more prone to pick up
noise signals

It has more system performance
than twisted pair

It is expensive than Twisted Pair
It is less prone to noise signals

High System Performance

It is Expensive

Low Signal Loss

More fragile than electrical cable
Immune to Noise

10) Name three wireless channel of communication
Radio Wave Satellite Infrared Bluetooth
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Point to remember for 4 Marks Networkin tion

Layout — Diagrammatically show Bus Topology & Star Topology

60 Computers

30 Computers

Hub/ Hub/

Business) Technology =
Block “ Block ‘
Hub/ 40

Switch H“!“/
Switch

Law HR
Block Repeater Center \

10 Computers 100 Computers

Location of Server
The most suitable place / block to house the server of this organisation would be the
Block that contains the maximum number of computers

Justification:
As it decreases the cabling cost for most of the computers as well as increasing the efficiency of
the maximum computers in the network.

Location of Repeater

Repeater will be placed where the distance between two blocks 90 meters or more
Justification

As the signal loss will take place after 90 meters, Repeater would ideally be needed along their
path to avoid loss of signals during the course of data flow in these routes.

Location of Hub/Switch

Hub/Switch will be placed in every block

Justification

To interconnect the group of cables from the different computers in each block

Radio wave transmission as it is the most economic option with to connect it with a reasonable
high speed

TCP/IP Dial Up as it is the most economic option with a reasonable

speed. Non Economic where Cost is not in consideration
Fiber Optics /Satellite
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c) ABC Corporation (TTC) is a professional consultancy company. The company is planning to set up
their new offices in India with its hub at Hyderabad. As a network adviser, you have to understand
their requirement and suggest them the best available solutions. Their queries are mentioned in i) to
iv).

Physical Locations of the blocks of ABC

Human

Conference
Resource

Eindfige Technology

Block to Block distances (in Meters) Number of computers in each block/center

FROM TO Distance Block / Center Computers
Human Resource Conference 110 Human Resource 25
Human Resource Finance 40 Finance 120
Conference Finance 80 Conference 90
Technology Finance 95 Technology 75

i)  What will be the most appropriate block, where TTC should plan to install the server?

i) Draw a cable layout connecting the blocks for most efficient communication. Also suggest a
topology for the network.

iii) What will be the best possible connectivity (out of Satellite Link, Infrared, Ethernet cable) you
will suggest to connect the new offices in Bangalore with its London based office?

iv) Which of the devices (Switch, Modem, Gateway) will be suggested by you to connect each
computer in each of the buildings.

c) Which type of network (out of LAN, PAN, MAN) is formed
i)  When four computers are networked using twisted pair cable?
i) Using mobile’s Bluetooth to share files among friends inside a room?
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Flash

1. What is a Layer? Give three properties of a Layer.
It is a type of frame that is placed one after another to create the animation or a movie. It's the
important component of Timeline. The properties of a Layer are:

1. Layer Name

2. Show and Lock

3. Type
2. What are Symbols? How is it different from instance
The Symbols are the reusable media elements such as graphics, buttons, movie clips etc. that can be
used in a movie. They are saved inside the library file and remain accessible as the global resources.

Instance It is a copy of master Symbol but any change we make in instance will not be updated or
reflected in symbol in the library.
3. What is a Frame? What are Frame Buffer and Frame Rate?
It is a segment of a movie that is mainly used for creating and storing the objects. It is one of
the important components of Timeline in Flash.
4. What is a Frame Buffer? What FPS?
The way of storing a movie or animation before displaying it is called Frame Buffer.
Frame per Second or Frame rate is the number of animation frames displayed per second. It
increases or decreases the speed with which the movie is displayed on the screen
5. What is publishing? What are two formats which support movie files?
Publishing means delivering a complete movie or a animation to the viewers. The two formats in which a
movie can be published are .SWF and .AVI.
6. What is a Key frame? What is the use of Stage?
It is a frame in flash that allows the users to define a change for an animation or to include the frame
actions to modify a movie.
Stage is the actual canvas in flash where all the objects to be included in a movie or animation are
placed. It allows to the draw the graphics and preview the movie in design time.
7. What is Timeline?
The Timeline is used to organize and control the contents of a movie over time in the layers and frames
so that each movie instance can occur at the correct time. The major components of the Timeline are
layers,frames and the play-head.
8. What is Tweening? Name any two types of Tweening?
The Tweening is the way of creating the effects on a movie or an animation. The two types of
Tweening are:-
1. Shape Tweening
2. Motion Tweening

9. Explain the steps to create a Tweening(Shape Tweening).

The following are the steps for Shape Tweening:-
Draw a shape, let's say Sun on the first frame in Flash Studio/Photoshop.
Place the Playhead at the 40" frame and insert a Keyframe.
Drag the object by using the Selection Tool, select both stroke and the fill options.
Place it op the right hand side of the Stage.
At the 40" frame, delete the Sun shape and draw another shape, let's say Cloudy Rain.
Place the Playhead at the first frame and right click over it.
Select Panels and then Frame. In Tween Option, select the shape and in blend option
select “ Distributive”
Publish it to preview the animation or the movie.
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10 Hiding a Layer & Locking A Layer

Hiding a layer means that the contents of that layer are not visible done using Eye icon on Layer
Locking a layer means that the contents of that layer cannot be edited done by using Ped lock icon

on Layer

11. What is Publishing. Name different format on which the flash movie can be published
Publishing a Flash Movie means delivering a completed movie to an audience by converting

the Flash .FLA file to another format for playback.

File formats in which a Flash movie can be published are: .SWF, .HTML, .GIF, .JPEG,.PNG, .EXE,

.HQX, .MOV, .SMIL.

12. Explain the concept of Scenes in Flash

A scene is a clip of a movie which can be treated as an entire single unit all on its own and
arranged around other clips. The advantage of breaking the movie into scenes is that every
scene can be accessed individually an thus the sequence or order of scenes can be changed.

13. Differentiate between

.FLAfile

.SWF file

.FLA is the extension of the flash source file.

.SWF is the extension of the flash publish
file.

.FLA file can be opened and edited at any point of
time

.SWF file cannot be edited, it can only be
viewed.

TIFF

MPEG

Tagged Image File Format

Moving Picture Experts Group

It is type of file format meant for storing images,
including photographs and other line arts.

is another type of file format formed by
ISO for the storing and transmission of audio
and video contents.

JPEG

GIF

Its full form is Joint Photographic Engineering Group.

Its full form is Graphics Interchange
Format.

It supports high resolution and can take 24 bits color
combinations yielding millions of colors.

It does not support high resolution and can
take 8 bits color combination yielding only 8
colors.

Graphic Symbol

Movie Clip Symbol

Graphic symbol is a still or static image/Object

Movie Clip Symbol is an Animated Image or
motion object

Graphic symbol operate in sync with the main time line

Movie clip is independent of the main timeline

Graphic symbol don’t have its own time line

Movie Clip have its own time line for its
animation

Symbol

Instance

Reusable Object that can be used in flash movies

It is occurrence of Symbol placed on stage

Stored in Library

Instance is placed on stage

Change in Symbol will change all instance of symbol

Any change in Instance will not change in
Symbol
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Guide layer Mask layer

Guide layer is used to assign an animation path that | Mask layer is used to create a hole through
links to an object on another layer during motion | which the contents of one or more
tweening, we can use the drawing tools in the | underlying layers are visible.

toolbox to draw the guide path.

Key frame Blank Key frame

A key frame is a frame in which the user can define 1. Ablank key frame is one which is empty
a change in an animation or include frame actions and is waiting to be filled.
to modify a movie.

Key Frame is denoted by Dark filled black circle Blank frame is denoted by hollow circle

Shape tweening Motion tweening

Shape tweening refers to making one shape Motion tweening refers to changing the
appear to change into another shape over position of an object over time.
time.

It is not done on Symbol It can be done on Symbol Only

Denoted by Light Green Color on Time line Denoted by Purple color on Timeline

14.How to Add sound in Flash timeline
Choose File > Import > Import to Library from the menu. Open file dialogue box appear Find and
select sound file and click Open. The file now appears in the Library.
Drag the required file from Library and place it on frame form where you want sound to start

15. What is the use of the onion skinning feature?
The onion-skinning feature allows the designer to see multiple frames and how their movements relate
to the current frame. When creating an animation, this feature can be a great help to see what the
objects in the preceding and succeeding frames look like.

16. What is the use of the Publish Preview option?
The Publish Preview option allows one to preview the movie in a browser before publishing to see if the
movie is appearing fine.

17. How Graphic symbol is different from Button Symbol
Graphic Symbol are used for static image and to create reusable piece of animation that are tied
up with main timeline.
Button Symbols are used to create interactive buttons that respond to mouse clicks, rollover or
other action

18. What do you understand by alpha value?
Alpha Value determine the transparency of color or layer

19. Explain the usage onion skin feature
Onion Skin feature display frame by frame movement of animation with reference to current
frame
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20. Identify the different Part of Flash Interface

@ Macromedia Flash Professional 8 - [Untitled-1*] Menu Bar
Fie Edit View Insert Modify Text Commands Control Window Help

o

# Scene 1
=80 5
| Piayert /s szl
Layers Timeline
el ® ¢ alo B e 2 (206 | 0o (<]

—— Toolbar

Panels

G. N3N0\~
ollavpg>» i~

Work Area
<
1| b Actions
'™ properties * Fiters | Parameters S
|7 Document ’ Size: Background: | _ Frame rate: | 12 fos
| Publeh: Player: 8 ActonSoipt: 2 Profile: Default

s Properties Panel

Untitied-1

21. Study the figure given below and answer the questions that follow:

Shock.fla*

Timeline #5 Scene 1
- ﬁm 1

“"% Motion o o Oils

W Face2 VAR -

@ Face1

Name the guide layer in the above scenario. Ans Motion

Given the above settings, will the contents of the layer Motion be displayed in
the final movie? Justify. ANs Yes

Given the above settings, name the active layer. Ans Face 2

What does the number 55 in the area labelled as A signify in the above
scenario?

Ans Current Active Frame where Play head is positioned

What does the number 12.0 fps in the area labelled as B signify in the above
scenario? Ans Frame rate

What does the number 4.5 s in the area labelled as C signify in the above
scenario?

Ans: Time of animation already played
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22. Observe the figure given bellow and do as directed :

o The text “learn flash 5.0 in three days” shows the position and size in frame 1.
e The solid circle image shows the position and size of the image for mask layer.

Write the procedure and property settings for animating the above scenario.

Steps for Masking

At Frame 1 of layer 1, draw a text box and write “learn flash 5.0 in 3 days” in it using text tool.

Go to Frame 50 and insert a keyframe.

Insert a new layer and convert it to mask layer and right clicking on Layer and choosing Mask Layer.
At Frame 1 of Mask layer, draw a circle and keep it at its initial position in the animation (at the start of
text box).

Insert a keyframe at Frame 50 of Mask layer and place the circle at its final position in the animation
(at the end of text box).

Select any frame from frame 1 to frame 50.

Select Create Motion Tween.

23. Consider the figure given below and do as directed:

The circle on the left hand side shows the position and size of the image for frame 1. The
colour of the image is red.
The circle on the right hand side shows the position and size of the image for frame 20. The
colour of the image is yellow.
The circle on frame 1 moves and transforms into a semicircle on frame 20.

Write the procedure and property settings for animating the above scenario.

The following steps have to be followed to animate the given scenario:

Select frame 1 from the timeline and select Insert > New Symbol - Graphic

Create the red coloured figure given on the left hand side.

Insert an instance of this symbol in frame 1 by dragging it from the library window.

Select frame 20 from the timeline and Select Insert > Keyframe

Change the size and shape of the image using Free Transform tool

Change the colour of the object by selecting Tint option from the Effect palette and selecting
the new colour.

Select any frame between 1 and 20

Select Create motion tween .
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24.0bserve the figure given below and do as directed:
e The first image shows the position and size of the image for
frame1.
¢ The second image shows the position and size of the image for
frame 40.
e The curved line shows the path of motion of the ball.
Write the procedure and property settings for animating the above scenario.

The following steps have to be followed to animate the given scenario:

Select frame 1 from the timeline and drag the image of tower from the library to the stage.
Select Frame 40 from the Timeline and select Insert Keyframe.

Insert a new layer, name it circle.

On the Circle layer, and draw the desired circle using the Oval tool and then convert it into a
Graphic symbol by selecting ‘Convert to Symbol’.

Select frame 40 on circle layer and select Insert Keyframe.

Select any frame between 1 and 40 on the circle layer and select Create Motion Tween.
Click on Insert and select Guide layer.

Draw the required path on the Guide layer using the Pencil tool.

Click on Circle layer and align the circle with the path at both ends.

Run the movie.

25.0bserve the figure given below and do as directed:

A

The graphic on the left hand side shows the position and size for frame 1.
The graphic on the right hand side shows the position and size for frame 30.
e The triangle graphic used in the animation is saved in the flash library.

Write the procedure and property settings for animating the above scenario assuming that the
color of the object remains the same.

The following steps have to be followed to animate the given scenario:

(i) Select frame 1 from the Timeline and drag an instance of the oval graphic from the oval from
the library on the stage.
Using the selection tool select the image and place it on the left hand side and make its colour
as orange.
Select frame 30 from the Timeline and select Insert->Keyframe.
Using the selection tool, select the image and position it to the right hand side of the stage at
the desired location.
Using the Free Transform tool, select the image and then resize it and rotate it as given.
Using the Selection tool, select the image and change its colour to green.
Select any frame from 1 to 29.
Right click the mouse button and select Create Motion Tween.
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HTML
1. What is HTML
Hyper Text Markup Language is a computer based language used to create WebPages.

2. What is the use of HEAD element?
It is used to provide information about the page.

3. Explain <BASEFONT>.
It is a non-container tag used to specify the font and its features for the entire webpage.

4. What is the use of Title tag?
It is used to provide the name of the webpage as can be seen on the title bar of the browser or tab
header.

5. Name three Attributes used with <BODY> tag.

They are:

Bgcolor : Background colour

Link: Specifies colour of all links that appear on the page

Alink: Specifies colour of links when clicked

Vlink: Specifies colour of links after it is visited by clicking

Background: Location of picture to be used as background for the page
Text : Default color of Webpage text

6. How can we give comments in HTML?
Using <!--...... -->
Where represents the comment to be entered.

7. What is the use of <FONT> tag in HTML and give three attributes which we use with
it?

The <FONT> tag is the formatting of a specified word or sentence.

Three attributes are:

Face: Decides type of font e.g. Arial

Size: Decides the size of the font

Color: Decides the colour of the font

8. What are the purpose of <h1> ...</h1>, ,<h6>...</h6>?
They are used to specify headings of pre-determined sizes.
<h1>...</h1> is the largest and <h6>...</h6> is the smallest.

9. How<BR> tag is different from <P>tag?
<BR> <pP>
It is a non-container tag. It is a container tag.
It creates a line break for every time it is It doesn’t creates a line break for every time
repeated. it is repeated.
It creates one line break. It creates a link break before and after the
entered text.
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10.How<BR> tag is different from <HR> tag?

<BR> <HR>

It creates a line break. It creates a line.

It does not have attribute It has Attribute like color, size, width

11.What is the purpose of Type attribute used in List?
It helps in the formatting of the list item marker.
Fore.g.:
<ol type="1">

</ol>
The above would result in a list where the item markers are Roman Numerals.

12.What is the purpose of Start attribute with the List?

It helps in deciding the starting position of the list which can only be used in Ordered lists.

For e.g.:

<ol start="5" type="a">

</ol>
This would result in a list where the first list marker is ‘e.’
13.Which HTML tag is used to insert image in HTML?

The tag used is the <IMG> tag.

Which attribute is used to show text instead of Image if browser do not support image?

The attribute used is display text instead of image if browser does not support image

<img src="R.jpg” alt="Imagname”>

This would result in a blank box with ‘Imagename’ written inside it if the image doesn’t load.

14.How can we create a link to image?
By using the following code:
<a href="a"><img src="b"></a>
Where a is the URL and b is the image location.

15. What is the use of <CAPTION> tag?
It is the tag used to give a caption for a table.

16.What do you understand by COLSPAN & ROWSPAN?
They are both attributes used in the <TD> & <TH> tag.
COLSPAN: Specifies the no. of columns that the table data covers
ROWSPAN: Specifies the no. of rows that the table data covers

17. What is Cell padding and Cell spacing?
They are both attributes used in the <TABLE> tag.
Cell padding: Itis used to decide the space between the table data and the walls of the cell.
Cell spacing: It is used to decide the space between neighboring cells and the space between the
cell and the table borders.

MMWT-SAMPLE PAPERS@ VKS-Learning Hub




Sample Paper-6

18. Differentiate between <input type="Text”> & <textarea>.

<input type="text”>

<textarea>

Used for information of usually one line

Used for information of usually more than one line

It is a non-container tag.

It is a container tag.

Eg.

<html>

<body>

<form name="f1">

Name: <input type="text” name="t1”
value="">

</form>

</body>

</html>

Eg.

<htmI>

<body>

<form name="f1">

Describe yourself: <textarea name="txt1” cols="5"
rows="10" value=""></textarea>

</form>

</body>

</html>

19. How is External linking is different from Internal linking?

External

Internal

Linking done between 2 different websites.

Linking done between 2 different webpages of the
same site or between 2 different parts.

Eg.

<html|>

<body>

<a href="www.wikipedia.org”>
Wikipedia

</a>

</body>

</html>

Eg.

<html>

<body>

<a href="1.html">
Wikipedia

</a>

</body>

</html>

20. Explain with an example how interlinking is done.

<a href="www.wikipedia.org”>
Wikipedia

</a>

</body>

</html>

. What are the two Attributes used for Bookmarking (Intralinking)

<html>

<body>

<a hame="top”>

Wikipedia

</a>

<a href="#top”>Go to Top</a>

</body>
</html>
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22. How to align Image to Center/Right/Left?
<html>
<body>
<img src="R.jpg” align="position”>
</body>
</html>
Where position refers to center or right or left.

23. What is radio button how is it different from checkbox?
Radio Checkbox
It used in the case of selection of one option | It used in the case of selection of one or
out of possible many. more options out of possible many.
Eg. Eg.
<html> <html>
<body> <body>
<form name="f1"> <form name="f1">
Choose sport: Choose favourite sport/sports:
Football Football
<input type="radio” name="r1" value=""> <input type="checkbox” name="r1" value="">
Basketball Basketball
<input type="radio” name="r1" value=""> <input type="checkbox” name="r1" value="">
</form> </form>
</body> </body>
</html> </html>
Name the tag which is used to set checkbox as selected by default.
It is checked.
<html>
<body>
<form name= “f1”">
Choose favourite sport/sports:
Football :<input type="checkbox” name="r1" checked>
Basketball: <input type="checkbox” name="r1">
</form>
</body>
</html>

25. What is the use of Action attribute in form?
The action attribute decides where the form data goes.

26.Differentiate between Text & password interface elements of form.

Text Password
It is a textbox which allows viewing of the It is a textbox which allows viewing of the entered
entered data. data in the form of a common character such as *
<form name="f1"> <form name="f1">
Name: <input type="text” name="t1" Password: <input type="password” hame="p1”
value=""> value="">
</form> </form>
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27.What is the use of Maxlength attributes with <input>tag?
The maxlength attribute decides the maximum number of characters that can entered.

28. What is the difference between Submit & Reset Button?
Submit Reset
It submits the form data to give a pre- It resets the form allowing for the re-entering
specified location. of data.
Eg. Eg.
<html> <html>
<body> <body>
<form name="f1"> <form name="f1">
<input type="submit” name="b1” <input type="reset” hame="b2"
value="Submit”> value="Cancel>
</form> </form>
</body> </body>
</html> </html>

29. Write the name of tag and attribute used to have 3 pixels thick horizontal line centralized
across 50%
<Hr Align= Center Width =50% Size=3px>

30.Insert an email link to image (MapleLeaf.jpg) with the width and height both set to 400
px Specify the tag and attributes to Send a form to the email address
mymail@emailaccount.com.

<A Href= “mailto: mymail@emailaccount.com” ><img src= “MapleLeaf.jpg” width =400 height=400></A>

31.Write the HTML code to generate a Web Page in the format given below :
i) Write a HTML code to create a framed webpage in the following
e The Page is divided into two frame vertically
o The left frame is 20% of the page width and display file “ Web.html”
o The right frame is 80% of the page width and displays file “tech.html”

Web.html Tech.html

+«—20% —»

<HTML>

<Frameset cols= “20%,80%"
<Frame Src= “Web.htm!”>
<frame src= “tech.html!”>
</Frameset>

</Html>
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32. Name the TAG and ATTRIBUTE to be used in the following situation
i) To give the color of the border of a frame

<frame src="headercolor.htm" bordercolor="blue">
ii) To display the cell content at the bottom of the cell of a table

<td valign="bottom">

iii) To sets the top/bottom margin of the web page.
<body topmargin=2 bottommargin=0>
iv) Text colour of main heading on the page should be “Red”.
<h1 color ="red”> Heading </h1>
v) Background colour of the page should be “black”, text color should be “white” and link colour should be
“Green”.
<body bgcolor="black” text="white” link= “green”>
vi) Font face of text in the page should be “Arial”.
<font face= “arial”>
vii) Image used in the page is the file “earth.jpg” of size 200 x 200 right aligned on page.
<img src="earth.jpg” height=200 width=200 align = “right”>
viii) The table should have a border of 3 pixels and the background color “Yellow”
<table border=3 bgcolor="yellow”>
ix) first row of table should be “Aqua” in colr
<tr bgcolor =”aqua”>
X) The bottom message should be of size 2 and the text “mail to us” is an E- mail link to the e-mail
address saveEarth@who.info .
<font size=2><A href=mailto:saveEarth@who.info>E-Mail</A></font>
xi) Image used at the bottom is noticel,jpg and it acts as a link to notice.html
<A Href= “Notice.html”> <img src=notice1.jpg”’></A>
xii)  To create a textbox which can accept maximum of 20 characters with a default value “Enter Name’
<input type= “Text” Maxlength=20,value="Enter Name”>.
xiii) Specify the tag and attributes to create a TextArea with 5 rows and 20 columns.
<TextArea rows=5 cols=20></TextArea>

33.What is the purpose of select tag . or how to create list box/drop down list
Select Tag is used to create drop down list
<select name="cars">

<option value="volvo">Volvo</option>
<option value="saab">Saab</option>
<option value="opel">Opel</option>
<option value="audi">Audi</option>
</select>

34. Name the tag and attribute used to set a target frame in HTML.
Base Target Tag is used inside the head tag to set the target frame in HTML
It will make the html page to open in selected frame only.
<head>
<base target="frame_name">
</head>
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35. What is the use of the ALT attribute of an <IMG> tag?
Specifies an alternate text for an image , it will be displayed if browser does not support image <<
<img src="Image1.jpg” ALT= “Image 1 is here”>

36. What is the use of <EMBED> tag? Write any three attributes of <EMBED> tag.
The <embed> tag defines a container for an external application or interactive content (a plug-in). We
can use this tag to add sound movies or flash file
Attribute are src, height, width & type

. Write a HTML code line to print the following chemical formulae Na,SO4
Na<sub>2</sub>SO<sub>4</sub><sup>-2</sup>

. What is the use of # sign in intra file linking in HTML?
# is used to provide reference to Anchor Name in Bookmark
<A Name=Top>
<A Href="#Top"> Top</A>

39.Name the tag and attribute used to set a checkbox as selected by default.
<Input Type= “Checkbox” value="Car” Checked>
Code Output

<form action="demo_form.asp" method="get"> r
<input type="checkbox" nhame="Ch1" >Bike<br>
<input type="checkbox" name="Ch2" checked>Car<br> v
<input type="submit" value="Submit"> Car

Bike

</form>
Submit

40.Explain the Definition List with a suitable example

Definition lists create a list with two parts to each entry: the name or term to be defined and the
definition. This creates lists similar to a dictionary or glossary. There are three tags associated with the
definition list: 1) <dI> to define the list 2) <dt> to define the definition term 3 <dd> to define the
definition of the term

Output

<dl> Coffee
<dt>Coffee</dt> Black hot drink
<dd>Black hot drink</dd> Milk
<dt>Milk</dt> White cold drink
<dd>White cold drink</dd>
</dI>

MMWT-SAMPLE PAPERS@ VKS-Learning Hub



http://webdesign.about.com/od/htmltags/p/bltags_dl.htm
http://webdesign.about.com/od/htmltags/p/bltags_dt.htm
http://webdesign.about.com/od/htmltags/p/bltags_dd.htm

Sample Paper-6

41 Write a code to create table given in fig
Table border is red cell of first two rows should have different
color use spacing and padding accordingly shown in fig

Code

<html>

<body>

<table cellspacing=5 cellpadding =5 border=2 bordercolor="red">
<tr>

<td bgcolor="yellow" rowspan=2>Class</td>

<td bgcolor="pink"rowspan=2>Section</td>

<td bgcolor="Green"colspan=2> Marks</td> </tr>

<tr>

<td bgcolor="purple">English</Td><Td bgcolor="blue">Maths</td> </tr>
<tr>

<Td> Xll </Td><Td> A </Td><Td> 90</Td><Td> 80 </Td> </tr>
<tr>

<Td> Xll </Td><Td>B</Td><Td> 80</Td><Td> 90 </Td> </tr>
</Table>

</Body>

</HtmI>

Code Display

<frameset rows="16%,84%">

<frame src="top.htm" name="top">

<frame src="bottom.htm" Bt
name="bpottom">

</frameset>

<frameset rows="16%,84%">

<frameset cols="50%,50%">

<frame src="topleft.htmI" name="tI">

<frame src="topright.html" name="tr">

</frameset> Bottorn. html
<frame src="bottom.html|" name="bottom"> ottom.ntm

</frameset>

<frameset rows="16%,84%">

<frame src="top.htm" name="top">

<frameset cols="50%,50%">

<frame src="left.htm" name="left">

<frame src="right.htm" name="right"> right.html
</frameset>

</frameset>
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<frameset rows="50%,50%"
cols="50%,50%">

<frame src="topleft.htm" name="topleft"> Topleft.html
<frame src="topright.htm"
name="topright">

<frame src="botleft.htm" name="botleft">
<frame src="botright.htm"

name="botright"> _
</frameset> botright.html

<FRAMESET cols="20%, 80%">
<FRAMESET rows="100, 200">
<FRAME src=" framel.html|">
<FRAME src=" frame2.gif">
</[FRAMESET>
<FRAME src=" frame3.html">
<NOFRAMES>
<P>This frameset document contains:
<UL>
<LI><A href="frame1.htm|"> framel.html
Some neat contents</A>
<LI><IMG src=" frame2.gif" alt="A
neat image">
<LI><A href="frame3.html"> ” MQSQ“!.LEQRNING HUB
Some other neat contents</A>
</UL>
</NOFRAMES> frame2.gif
</FRAMESET>

<NOFRAME> Tag contain the html content which will be displayed if browser does not
support frame document. It’s a container tag. Closed by </noframe>

If we don’t use <NoFrame> Tag and Browser does not support Frames, in that case Error page
will be displayed by the browser

<NOFRAME> TAG basically helps stopping the error page instead displayed the content which is
basically a link to a non frame page

<Base Target= “ Target Frame name”> Tag is used to link a frame/Window where the
hyperlinked webpage of other frame will be displayed . <Base target = “”’> is used to open all link
document to be open in particular frame of frameset/ Window.

<Base Target= “ Target Frame name”> is always declared in <head > tag of HTML Webpage
Page
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.,é.) NATIONALYEAR OF MATHEMATICS

125 TH BIRTH ANNIVERSARY OF

SRINIVASA RAMANUJAN

Prime Minister on 26 October 2011 declared the birthday of the great mathematician
Srinivasa Ramanujan, 22 December as National Mathematics Day. PM also declared 2012 as
the national mathematical year.

The Ramanujan Mathematical Society will hold a series of activities in 2012 to mark the
125th birth anniversary of the mathematician.

The activities involve different scetions like:
» School goers
s Colege students
s Research Fellows

Programme Details

Event | | Details

Opening Prime Minister inaugrates the year long celeberations at the Madras
Ceremony University Auditorium

Talks and activities would focus on helping students get rid of their fear of

Activities . . . .
the subject and improve their skills

Closing International Conference of Mathematicians in New Delhi in december
ceremony 2012

For enquiries mail us at RMSExyz. com

Consider the following points while writing the HTML code:
The title of the web page is Mathematics Year.
The style of the page is Trebuchet MS.
The image used is Maths1.jpg
The table has a red colored border that is 5 pixels thick.
The space between cells is 5 pixels.
Use the concept of lists to create the given lists.
The link at the bottom is an e_mail link to the address RMS@xyz.com

<html>

<head> <title>Mathematics Year</title> </head>

<body>

<font face ="Trebuchet MS">

<center><img src="mathsl.jpg"></center>

<pP>

Prime Minister on 26 October 2011 declared the birthday of the great mathematician Srinivasa
Ramanujan, 22 December as National Mathematics Day. PM also declared 2012 as the national
mathematical year.

<p>

The Ramanujan Mathematical Society will hold a series of activities in 2012 to mark the 125th birth
anniversary of the mathematician.
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<pP>

<ul>The activities involve different scetions like:
<li>School goers

<li>Colege students

<li>Research Fellows

</ul>

<hr>

<table border=5 bordercolor=red cellspacing=5>
<caption>Programme Details</caption>

<tr>

<th>Event

<th>Details

</tr>

<tr>

<td>Opening Ceremony

<td>Prime Minister inaugurates the yearlong celebrations at the Madras University Auditorium
</tr>

<tr>

<td>Activities

<td>Talks and activities would focus on helping students get rid of their fear of the subject and
improve their skills

</tr>

<tr>

<td>Closing ceremony

<td>International Conference of Mathematicians in New Delhi in December 2012
</tr>

</table>

<font size = 2>For enquiries mail us at

<a href = “mailto:RMS@xyz.com">RMS@xyz.com</a>
</body>

</html>
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Save girl child, educate girl child

Save girl chald, educate girl child (Befi Bachao, Beti Padhao) 1s
a Government of India scheme that aims to generate awareness and
improving the efficiency of welfire services meamt for women.

Project Implementation

1. At the Nahonal level
2. At the State level
3. At the Dhsirict level

The abjectives of this mitiarive are
Ensurnmg
education and

£ participation

of the @il

child

Prevention of [Ensuring
pender biased survival &
zex selective  protection o
elimination  the girl child

For Further Enquines

Consider the following while writing the HTML code
Title of the page should be “Save Girl Child”
Link colour should be “Maroon”, visited link colour should be “Red”.
Heading of page is “violet”
Picture used in the page is the file “savegirl.jpg”
Table should have a border of width 1, border of table should be “green”.
Background of first row is “yellow” and of second row is “cyan”
Pages linked to :
e At the National level as “national.html”
e At the State level as “state.html”
e At the District level as “district.html
Bottom message is of size 2 is linked to email-id savegirl@abc.com

<htm|>

<head> <title>Save Girl Child</title> </head>

<body LINK="maroon" VLINK="red" >

<h1 align="center">Save girl child, educate girl child</h1>

<hr>

<img src="savegirl.jpg" width="142" height="127" align="right">

<strong>Save girl child, educate girl child (BetiBachao, Beti Padhao) </strong>is a Government of
India scheme that aims to generate awareness and improving the efficiency of welfare services
meant for women.</p>

Project Implementation

<ol>

<li><a href="national.htm|">At the National level</a></li>

<li> <a href="state.html">At the State level</a></li>

<li> <a href="district.htmI">At the District level</a></li>

</ol>
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<table width="300" border="1" bordercolor="green" >

<tr bgcolor=yellow>

<td colspan=3><center>The objectives of this initiative are:
</center></td>

</tr>

<tr bgcolor=cyan >

<td width="100">Prevention of gender biased sex selective
elimination</td>

<td width="100">Ensuring survival protection of the girl
child</td>

<td width="100">Ensuring education and participation of the girl
child</td>

</tr>

</table>

<hr>

<FONT SIZE=2 > <p align="center"><ahref="mailto:savegirl@abc.com">For Further
Enquiries</a></p></font>

</body>

</html>
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